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Course Description

QAD designed this course to cover the basics of preparing to set up and use the QAD Demand 
Management (DM) program. The course includes hands-on activities and exercises that allow 
students to practice key concepts and processes in DM.

Course Objectives

By the end of this class, students will:

• Understand the importance of Demand Management in a business enterprise

• Recognize the impact of forecast errors on inventory levels and customer service

• Analyze some key business decisions before setting up DM

• Determine business requirements for setting up and using DM

• Understand the relationships of components in the DM program & Planning Portal

• Set up DM to best match the business rules of an organization

Audience

• DM technical support 

• Appropriate business managers

• Implementation consultants and members of implementation teams

• Key end users

Prerequisites

• Demand Management User Learning Path

• Practical Guide to Business Forecasting (available April 15, 2012)

Course Credit and Scheduling

QAD designed this course to take 32 hours.

System Requirements

This course uses the QAD Enterprise Applications Enterprise Edition database. See the title page 
for the exact database title. Whether you are studying this material in a classroom or as a self-study 
exercise, this is launched in a virtual environment management system. QAD instructors will 
prepare classroom environments. If you encounter questions or problems on QAD software that 
are not addressed in this book, several resources are available.

Virtual Environment Information

Enterprise Edition 2011 Add-Ons r02, 10USACO
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QAD Resources

If you encounter questions or problems on QAD software that are not addressed in this book, 
several resources are available.

Product Help

All QAD products ship with integrated help systems. A properly installed QAD application will 
display help when you press the Help key (F1), or access it through the menu. The help covers the 
normal use of the product.

QAD Web Resources

The QAD website provides product and company overviews. The Print Solution option on the 
opening page provides a means of compiling desired content into a document specialized to your 
industry, business implementation, and needs.

http://www.qad.com/

From QAD’s main site, you can access QAD’s Learning or Support sites.

QAD Learning Portal for Training Opportunities

To view available training courses, locations, and materials, use the QAD Learning Portal. Choose 
Learning under the Global Services tab to access this resource. 

QAD Support for Product Documentation and the QAD Knowledgebase

To access release notes, user guides, installation and conversion guides by product and release, 
visit the Support website. Support also offers an array of tools depending on your company’s 
maintenance agreement with QAD. These include the Knowledgebase and direct links to QAD 
Support experts.

Choose Support under the Global Services tab. 

Any QAD customer can register for a QAD web account by accessing the Support web site and 
clicking the Accounts link at the top of the screen. Your customer ID number is required. Access to 
certain areas is dependent on the type of agreement you have with QAD.
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Chapter 1 

Planning Portal Overview
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Planning Portal
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Meet With Customers
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DM 6.1 Users

Typical Users – Demand Planners, Sales Forecasters, Materials Managers, Supply Chain 
Managers.

• Responsibility – prepare & manage forecasts and forecasting process

• Typical System Access – Viewer

• Data Access – Living Master

Typical Users – Sales Managers, Marketing Managers, Regional Sales & Marketing Managers, 
Key Account Managers.

• Responsibility – manage and approve forecasts for their areas of responsibility

• Typical System Access – Viewer

• Data Access – Detailed Scenarios of their areas of responsibility

Typical Users – Field Sales, Product Managers, New Product Managers.

• Responsibility – input business intelligence including customer forecasts, promotional 
calendar, new product introduction schedule for their areas of responsibility

• Typical System Access – Portal or Viewer

• Data Access – Detailed Scenarios of their areas of responsibility
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Typical Users – Customers.

• Responsibility – input collaborative customer forecasts

• Typical System Access – Portal 

• Data Access – Detailed Scenarios of their company
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Planning Portal – Main Features
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Logging in to Planning Portal
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Home Page

For more info on the panels and data displayed on the Home Page, please refer to the PP03 Home 
Page training module. For more information on customizing the Home Page, refer to PP02 My 
Settings training module.
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Planning Portal - Recap
                                          



Chapter 2 

Home Page
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Home Page - Overview
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Planning Portal – Home Page

The Home Page can be customized using the buttons on the left to indicate the panels to display. 
Selected panels display in orange.
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Home Page Activation Bars
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Home Page - Customization
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Home Page – My Workflow

If all the available users cannot be viewed in the panel, click the linked number in the bottom right 
corner of the panel to view the next page.

• The toolbar shows the status for the current user

• The status options available and permissions to view other users’ status are configured in the 
Planning Portal Admin tool
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• Add any comments and click the Save icon next to the drop-down

• The status is updated and displays on the My Workflow panel
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Home Page – My Reports

• Use the drop-downs to change the Aggregate report criteria

• Click the “Show” link in the Link Report column to generate and view the report
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Home Page – My Notes
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Home Page – My Shortcuts

• Shortcuts are created using My Views portion of the Home Page

• Click the “Go” link in the Load column to run the shortcut and display the data in the selected 
view
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Home Page – My Exceptions

• Exceptions are created in the My Settings portion of Planning Portal

• Click the “Refresh” link in the Refresh Exception column to apply the exception in the 
selected view
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Home Page – My Charts

• If the user only has one chart created, it will display in the My Charts panel twice

• The criteria and settings for these charts can be selected in the My Settings portion of Planning 
Portal
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Home Page – My Shortcut Editor
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Data Views are assigned by your administrator and can be created on the My Settings page.
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Data Views are assigned by your administrator and can be created on the My Settings page.
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Home Page – Quick Start
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Home Page – Recap
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My Settings
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My Settings - Overview
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Home Page Tab
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My Workflow Tab

My Tasks vs. All – use this to display all tasks or only your tasks.

• Current vs All

• Current will show tasks and process that are due for this cycle

• All will show all tasks and processes that a user can see regardless of cycle

• Workflow List Field

• Process is the group of one or more tasks

• Task is the task description for the user

• User Name is the user the task is assigned to

• Cycle is the period the task is due 

• Action – Actions the user needs to take

• Options are: Reports, Shortcuts, Exceptions, None

• Deadline – specific date when the task is due

• Status – The user will assign the status of the task from the Home Page

• Select – Use this check box to select the rows for “Change Status”
                                          



My Settings      41
My Reports Tab

• View – Run the report and view the results

• Create – Define a new report

• Edit – Edit an existing report

• Delete – Delete a report
                                                 



42     Training Guide — Demand Management 6.1 Planning Portal
My Notes Tab
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My Charts Tab

There are eight different types of charts and graphs that you can display on the My Charts panel:

• Column

• Stacked Column

• Bar

• Stacked Bar

• Line

• Pie

• Doughnut

• Concentric Doughnut
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My Shortcuts Tab
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Field View Tab

• System administrators can grant permission to use other Field Views and give you access to 
series attributes

• Field Views are extensive and show a lot of data that may need to be filtered further

• Creating a Field View allows you to define the exact data lines and attributes you want to 
focus on

• Use the check boxes in the Selected column to choose the fields to include in the view
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Create a Field View

1 The new view is saved and added to the tree in the Field View List.

2 The new view can now be selected from the Field View drop-down on the My View panel and 
applied to your data.

3 Use the check boxes in the Selected column to choose the fields to include in the view.

4 Enter a descriptive title for this new view in the Name field above the Field View Settings.

5 Click the Save button.
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Data View Tab

• System administrators can grant permission to use other Data Views and give you access to 
series attributes. 

• Data Views are extensive and show a lot of data that may need to be filtered even further. 

• Creating a Data View allows you to define the exact data lines and attributes you want to focus 
on.

• Use the check boxes in the Selected column to choose the fields to include in the view.
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Create a Data View

1 The new view is saved and added to the tree in the Data View List.

2 The new view can now be selected from the Data View drop-down on the My View panel and 
applied to your data.

3 Use the check boxes in the Selected column to choose the fields to include in the view.

4  Use the check boxes in the Display Graph and Display Summery columns to indicate if the 
selected data lines will be available in the Graph and Summary sections.

5 Enter a descriptive title for this new view in the Name field above the Data View Settings.

6 Click the Save button.
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Filter Tab

Click the Create button to display the filter criteria fields below the drop-down and buttons.
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My Settings – Review 
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My Workflow – Overview
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My Workflow – Home Page

The configuration in PP Admin controls what each user will see:

• Users can update status for one or more tasks at a time

• Users can add or remove fields under My Settings

• Workflow reports can be accessed from PP or DME

• The Administrator will configure PP Admin with the Processes and Tasks that will be assigned 
to each user

• In this example there are six tasks under the S&OP process

• Some users may have access to see only their User Name and others could have access to a 
group of people and their tasks

• The Cycle refers to the monthly or weekly period for the process

• The Action column can be configured with links to Reports, Views, or Exceptions

• The Deadline is set by Task and Cycle by the Super User

• The default Status options are Initialized, In Progress, and Complete

• These options can be modified in PP Admin.

• The graphic field next to Status will change based on the combination of Deadline and Status 

• When you change the status the Date/Time will be updated and there is an option to save a 
Comment as well
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Update Status
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Update Status Graphics
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My Settings - My Workflow
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My Settings - My Workflow Tab

My Tasks vs. All – use this to display all tasks or only your tasks:

• Current vs All

• Current will show tasks and process that are due for this cycle

• All will show all tasks and processes that a user can see regardless of cycle

• Workflow List Field

• Process is the group of one or more tasks

• Task is the task description for the user

• User Name is the user the task is assigned to

• Cycle is the period the task is due 

• Action – Actions the user needs to take

• Options are: Reports, Shortcuts, Exceptions, None

• Deadline – specific date when the task is due

• Status – The user will assign the status of the task from the Home Page

• Select – Use this check box to select the rows for “Change Status”
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My Settings - My Workflow Initial Setup

The default setting for Cycle is “Current” and the other option is “All.” The current cycle is 
determined by the current date and where it falls in the demand periods.
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My Settings - My Workflow Example
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My Reports - Workflow
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My Workflow - Recap
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My Reports – Overview
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My Reports
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Creating a Report
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Previewing a Report
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My Reports – Review
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My Charts
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My Charts Home Page
                                                 



88     Training Guide — Demand Management 6.1 Planning Portal
                                          



My Charts      89
Customizing the My Charts Panel
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• In the Opinion Lines section, use the check boxes to select the lines you want to use to 
generate the charts

• In the Date Range field, set the time frame for the data used to generate the chart 

• Choose either a Fixed range (specific start and end dates) or a Sliding range (for example, 
a six month range that varies based on the current date)

• Use the Group By radio buttons to indicate whether the data is sorted based on either the 
Series Attribute or the time Period

• The Series Attribute drop-down allows you to choose an a specific attribute to group by. This 
field is only active if the Series Attribute option is selected in the Group By field

• The Default View drop-down is used to apply a custom view to the data when creating the 
chart
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My Charts - Recap
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Detail View - Overview
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Detail View
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Detail View – Data Selection
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Data Tab
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Properties Tab
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Graph View

To determine if an opinion line is editable, look at the Data Tab. If the observation is in a white 
cell, it can be modified. If the observation is in a grayed-out cell, it cannot be modified.
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Bar Charts

To determine if an opinion line is editable, look at the Data Tab. If the observation is in a white 
cell, it can be modified. If the observation is in a grayed-out cell, it cannot be modified.
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Display/Hide Detail Charts
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Adding Notes in Detail View
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Updating Data Settings in Detail View
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Updating Data Settings in Detail View
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Detail View - Review
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Summary View - Overview
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Summary View
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Summary View - Display
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Summary View – Detail View
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Summary View - Export

• After exporting, you can make edits or reformat the data if the cells in Excel are number 
formatted to “General”

• In a scenario with Daily Observations, the Excel file does not export all columns

• This is an Excel limitation, as it only supports 256 columns
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Summary View – Notes

• Hover the cursor above the Note icon to display a tool tip with the last note added

• Click on the Note icon to view a detailed notes history for this series
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Making Changes in Summary View
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Summary View - Recap
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Tools Menu Overview

The following options are included in the Tools menu and will be covered in this training module:

New Item

When a new series is forecasted, it can be added in the New Item tab by entering the SKU 
number and selecting the item’s Attributes from a drop-down list.

Mass Adjust

Apply Forecast adjustments to multiple series.

Promotions

This feature has been discontinued.

Profile Settings

Apply a pattern to a series forecast to compensate for either predictable growth or a decrease 
in a product's demand.

Retagging

Copy history, forecast, or any other Opinion Line from an old series to a new series.
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New Item
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Mass Adjust
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Selecting Filter Criteria
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Mass Adjustment
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Mass Adjustment Options

1 The Direction radio buttons indicate whether you want to Increase or Decrease the value of the 
opinion line.

2 The Adjusted By field indicates whether you want to adjust by either a set Percentage or a 
specific Amount.

3 Enter the value for the amount or the percentage you are adjusting in the Amount field.

4 In the Opinion Line field, select the lines on which to perform the adjustment.

5 Use the Start Date and End Date fields to select the date range you would like to use in the 
adjustment.
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Kit Adjust

This feature enables you to set specific values for certain periods. There is one field for each 
period within the date range you specified in the Start Date and End Date fields.

• You must enter a value in each of these periods. If any fields are blank, you will get an error 
message

• In the Reason for Mass Adjust text box enter a description for the reason this Mass Adjustment 
is being performed

• Click the Apply Adjustment button when finished

• The adjustment is applied to the selected series
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Profile Settings
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Profile Settings – Get Item
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Adding Profile Settings
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Profile Settings – Properties Tab

1 The Apply In field allows you to select where the profile is applied:

• Selected Series - Series you have selected from the Items tab

• Whole Tree - Scenario in addition to everything in the hierarchy

• Scenario - Entire Scenario. Use drop-down to the right to indicate which scenario

2 Use the check boxes in the Affected Data Field section to select from the available opinion 
lines.

• The opinion lines available here are configured by the System Administrator

• The Profile Scenario drop-down allows you to specify which scenario will contain the profile

3 In the table at the bottom of the screen, select a Profile from the drop-down box for each row. 
There is one series listed for each series in your profile scenario.

• Specify the date range for this profile using the Start and End fields

• Check the Offset box if you want it to offset to the Profile Start

• Enter the value to apply across the selected range in the Total field

• The Profile Start date indicates the date this profile becomes active

• Check the Profile Recycle box if you want the profile to cycle over the date range

• Click the Apply Profile button to apply this profile to the selected items

• Click the Save Profile button to save these settings for future use
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Retagging
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Retagging – View Tab
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Retagging – Add Tab

Retagging – Add Tab

• Specify source and target fields

• Use * to match multiple series

• Set date range, and whether to use history, forecast, or both

• Set the Retain% and Allocate%

• Retain: Percentage of source series to retain after retagging

• Allocate: Percentage of source series to add to target series

• Enable reforecast of source and target series, if desired

• Enable target reset, if desired

• Set target to “0” before retagging

• Click the Save button when finished
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